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MOTION SOFTWARE, INC. SOFTWARE LICENSE

PLEASE READ THIS LICENSE CAREFULLY BEFORE
BREAKING THE SEAL ON THE DISKETTE ENVELOPE AND
USING THE SOFTWARE. BY BREAKING THE SEAL ON
THE DISKETTE ENVELOPE, YOU ARE AGREEING TO BE
BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT
AGREE TO THE TERMS OF THIS LICENSE, PROMPTLY
RETURN THE SOFTWARE PACKAGE, COMPLETE, WITH
THE SEAL ON THE DISKETTE ENVELOPE UNBROKEN,
TO THE PLACE WHERE YOU OBTAINED IT AND YOUR
MONEY WILL BE REFUNDED. IF THE PLACE OF PUR-
CHASE WILL NOT REFUND YOUR MONEY, RETURN THE
ENTIRE UNUSED SOFTWARE PACKAGE, ALONG WITH
YOUR PURCHASE RECEIPT, TO MOTION SOFTWARE, INC.,
AT THE ADDRESS AT THE END OF THIS AGREEMENT.
MOTION SOFTWARE WILL REFUND YOUR PURCHASE
PRICE WITHIN 60 DAYS. NO REFUNDS WILL BE GIVEN
IF THE PACKAGING HAS BEEN OPENED.

Use of this package is governed by the following terms:

1. License. The application, demonstration, and other software accom-
panying this License, whether on disk or on any other media (the “Motion
Software, Inc. Software”), and the related documentation are licensed
to you by Motion Software, Inc. You own the disk on which the Motion
Software, Inc. Software are recorded but Motion Software, Inc. and/or
Motion Software, Inc.’s Licensor(s) retain title to the Motion Software, Inc.
Software, and related documentation. This License allows you to use the
Motion Software, Inc. Software on a single computer and make one copy
of the Motion Software, Inc. Software in machine-readable form for backup
purposes only. You must reproduce on such copy the Motion Software, Inc.
Copyright notice and any other proprietary legends that were on the original
copy of the Motion Software, Inc. Software. You may also transfer all your
license rights in the Motion Software, Inc. Software, the backup copy of the
Motion Software, Inc. Software, the related documentation and a copy of
this License to another party, provided the other party reads and agrees to
accept the terms and conditions of this License.

2. Restrictions. The Motion Software, Inc. Software contains copyrighted
material, trade secrets, and other proprietary material, and in order to protect
them you may not decompile, reverse engineer, disassemble or otherwise
reduce the Motion Software, Inc. Software to a human-perceivable form. You
may not modify, network, rent, lease, loan, distribute, or create derivative
works based upon the Motion Software, Inc. Software in whole or in part.
You may not electronically transmit the Motion Software, Inc. Software from
one computer to another or over a network.

3. Termination. This License is effective until terminated. You may terminate
this License at any time by destroying the Motion Software, Inc. Software,
related documentation, and all copies thereof. This License will terminate
immediately without notice from Motion Software, Inc. If you fail to comply
with any provision of this License. Upon termination you must destroy the Mo-
tion Software, Inc. Software, related documentation, and all copies thereof.
4. Export Law Assurances. You agree and certify that neither the Motion
Software, Inc. Software nor any other technical data received from Motion
Software, Inc., nor the direct product thereof, will be exported outside the
United States except as authorized and permitted by United States Export
Administration Act and any other laws and regulations of the United States.
5. Limited Warranty on Media. Motion Software, Inc. warrants the disks
on which the Motion Software, Inc. Software are recorded to be free from
defects in materials and workmanship under normal use for a period of
ninety (90) days from the date of purchase as evidenced by a copy of the
purchase receipt. Motion Software, Inc.’s entire liability and your exclusive
remedy will be replacement of the disk not meeting Motion Software, Inc.'s
limited warranty and which is returned to Motion Software, Inc. or a Motion
Software, Inc. authorized representative with a copy of the purchase receipt.
Motion Software, Inc. will have no responsibility to replace a disk damaged
by accident, abuse or misapplication. If after this period, the disk fails to
function or becomes damaged, you may obtain a replacement by returning
the original disk, a copy of the purchase receipt, and a check or money order
for $10.00 postage and handling charge to Motion Software, Inc. (address
is at the bottom of this agreement).

6. Disclaimer of Warranty on Motion Software, Inc. Software. You expressly
acknowledge and agree that use of the Motion Software, Inc. Software is at

your sole risk. The Motion Software, Inc. Software and related documenta-
tion are provided “AS IS” and without warranty of any kind, and Motion
Software, Inc. and Motion Software, Inc.’s Licensor(s) (for the purposes
of provisions 6 and 7, Motion Software, Inc. and Motion Software, Inc.s
Licensor(s) shall be collectively referred to as “Motion Software, Inc.”)
EXPRESSLY DISCLAIM ALL WARRANTIES, EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
Motion Software, Inc. DOES NOT WARRANT THAT THE FUNCTIONS
CONTAINED IN THE Motion Software, Inc. SOFTWARE WILL MEET
YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE Motion
Software, Inc. SOFTWARE WILL BE UNINTERRUPTED OR ERROR-
FREE, OR THAT DEFECTS IN THE Motion Software, Inc. SOFTWARE
WILL BE CORRECTED. FURTHERMORE, Motion Software, Inc. DOES
NOT WARRANT OR MAKE ANY PRESENTATIONS REGARDING THE
USE OR THE RESULTS OF THE USE OF THE Motion Software, Inc.
SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR
CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL
OR WRITTEN INFORMATION OR ADVICE GIVEN BY Motion Software,
Inc. OR A Motion Software, Inc. AUTHORIZED REPRESENTATIVE SHALL
CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF
THIS WARRANTY. SHOULD THE Motion Software, Inc. SOFTWARE
PROVE DEFECTIVE, YOU (AND NOT Motion Software, Inc. OR A Motion
Software, Inc. AUTHORIZED REPRESENTATIVE) ASSUME THE ENTIRE
COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.
7. Limitation of Liability. UNDER NO CIRCUMSTANCES INCLUDING NEG-
LIGENCE, SHALL Motion Software, Inc. BE LIABLE FOR ANY INCIDENT,
SPECIAL, OR CONSEQUENTIAL DAMAGES THAT RESULT FROM THE
USE, OR INABILITY TO USE, THE Motion Software, Inc. SOFTWARE OR
RELATED DOCUMENTATION, EVEN IF Motion Software, Inc. OR A Motion
Software, Inc. AUTHORIZED REPRESENTATIVE HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS
DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITA-
TION OR EXCLUSION MAY NOT APPLY TO YOU.

In no event shall Motion Software, Inc.’s total liability to you for all dam-
ages, losses, and causes of action (whether in contract, tort (including
negligence) or otherwise) exceed the amount paid by you for the Motion
Software, Inc. Software.

8. Controlling Law and Severability. This License shall be governed by and
construed in accordance with the laws of the United States and the State of
California. If for any reason a court of competentjurisdiction finds any provi-
sion of this License, or portion thereof, to be unenforceable, that provision
of the License shall be enforced to the maximum extent permissible so as
to effect the intent of the parties, and the remainder of this License shall
continue in full force and effect.

9. Complete Agreement. This License constitutes the entire agreement
between the parties with respect to the use of the Motion Software, Inc.
Software and related documentation, and supersedes all prior or contem-
poraneous understandings or agreements, written or oral. No amendment
to or modification of this License will be binding unless in writing and signed
by a duly authorized representative of Motion Software, Inc.

Motion Software, Inc.
222 South Raspberry Lane
Anaheim, CA 92808

©1995, 2024 to present By Motion Software, Inc. All rights reserved by Mo-
tion Software, Inc. MS-DOS, Windows, and Windows95/98/Me/NT/2000/
XP/Vista and Windows 7, 8, 10 and 11 are trademarks of Microsoft Corpo-
ration. IBM is a trademark of the International Business Machines Corp.
Dynomation™, Dynomation6™, DynoSimé™, and Motion Software™ are
trademarks of Motion Software, Inc.

All other trademarks, logos, or graphics are the property of their respec-
tive owners.
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INTRODUCTION

Note: If you can’t wait to start using this engine simulation, feel free to jump ahead to
INSTALLATION (or review the 16-page QuickStart Guide supplied with your software),
but don’t forget to review this manual when you have time. Also, please complete the
Registration Form that appears when you first start your software. It entitles you to
receive tech support, obtain free automatic program updates and more.

And make sure you have a look at our growing list of tech videos on YouTube:
youtube.com/@motionsoftwaresim

Thank you for purchasing Dynomation6™ or DynoSim6™ for Windows from Motion
Software, Inc. This software is the result of many years of simulation development
and programming effort that included program optimizations developed over twenty
years of on-going user feedback. This simulation was built, from the ground up, to
be easy-to-use, yet it is fully capable of advanced engine-simulation analysis that
can reveal WHY the IC (Internal Combustion) engine functions as it does. You can
view pressure waves and mass flow that
take place inside the intake and exhaust pas- .
sages. You can easily change components _D_Y_NOMATI,ON’ 4
and measure their affect on these pressure PR O W AAL
waves and on engine power. And you can Easy-To-Use Wave-Action Engine Simulation
learn more about how engines work than you Includos Powrful Simulatign Peaturos:
ever thought possible. Not only that, we are [ i i b o
confident that you will find this simulation e e
to be an intuitive, easy-to-use program that e
makes engine testing and analysis simple
and fun! By eliminating the frustration that
is common with many engineering-oriented

Part No. DYM6 www.MotionSoftware.com

Dynomation6™ (the full Wave-Action simula-
tion) is the most comprehensive yet easy-to-
use engine simulation software package ever > o
offered to performance engine designers,
builders and enthusiasts. Dynomation6 pro- "
vides full detail simulatoin analysis, optimum o ot P e e B
accuracy and a robust modeling toolset. ;

4 Explore and optimize
intake and exhaust flow
inside a running engine!
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- The simulation incorporates
Main Preram Screen a completely unique, intuitive
user interface (shown us-
ing one of several program
color schemes). If you wish
to change an engine com-
ponent, simply click on any
component field on the left
side of the screen and select
a new specification from
the drop-down list or enter
custom values. Engine com-
ponents are shared between
both the Filling-And-Emp-
tying (FE) and Wave-Action
(WA) simulation models.
Results can be displayed in
a wide variety of tables and
graphs.

simulations (or the huge expense involved in long dyno-test sessions), you are free to
“play,” using your imagination to uncover power secrets for single or multiple-cylinder,
four-stroke engines for automotive, racing, or a myriad of other applications.

What Are DynoSim6 and Dynomation6?

At the core of Dynomation6 and DynoSim6 are mathematical models that simulate
DooSi Softvare four-stroke, internal combustion (IC) engines

@ with remarkable accuracy. These simulations
= 16": incorporate two distinct models: 1) A Filling-
gf.y/'i'cgjaf> Bt And-Emptying (FE) method, provided in both

DynoSim6 and Dynomation6, that can calcu-

Engine-Dyno Simulation late a complete engine simulation with fewer

with Wave Action Pro-Tools" data iinputs, making this technique a fast and
accurate way to optimize engine designs,

- Easy To Use—Test Your Next ' = and 2) A full Wave-Action (WA) method ex-
Engine Before You Build it! - . . .

TN clusively in Dynomation6 that calculates and
« “Fitter” Accurately Models | A" S d .
Cams, Lobe-Profiles, Morel |, mi| ) predicts the complex pressure-wave dynam-
+Analyze Turbochargers, 250 ics and particle flows in intake and exhaust

Superchargers, intercoolers

« Test Any American, Import,
Stock Or Racing Engine!

> @ iy T DynoSim6™ uses FE (Filling-and-Emptying
. N . 2| model with pressure-wave analysis) simula-
Y -~ tion that offers ease of use and excellent
accuracy. It includes a comprehensive toolset
(developed in years of Dynomation6 devel-
opmenet) that add powerful calculators, cam-
timing and analysis tools and much more.
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passages. The Wave-Action model picks up where the Filling-And-Emptying method
leaves off and “homes in” on the best port sizes and shapes, runner lengths, header
configuration and tubing dimensions, cam timing, valve motion, and other engine
parameters, providing unprecedented accuracy for the serious engine designer and
builder.

Both DynoSim6 and Dynomation6 use a carefully-crafted Direct-Click™ user
interface that lets you select parts with a single mouse click. Multiple graphs and
tables display power, torque, engine pressures and many other engine variables both
independently and in comparison views.

You'll also find hundreds of other features that have become Motion Software’s
trademarks, including: 1) rapid lterative™ (fully automatic) testing, 2) comprehensive
camshaft, cylinder-head-flow, and engine-file imports, 3) built-in calculators for com-
pression ratio, airflow conversion, rocker-arm and cam-timing math, 4) side-by-side
graph QuickComparisons™, 5) professional multi-page ProPrint™ dyno-test reports,
and more! We are confident that you will find Dynomation6 and DynoSim6 to be the
most capable engine simulation software packages available for engine professionals
and serious enthusiasts.

How Dynomation6 And DynoSim6 Work

Dynomation6 and DynoSim6 are Windows 7, 8, 10 and 11, 32- and 64-bit, engine-
dynamometer simulations that utilize full-cycle analysis, meaning that they calculate
the complete fluid-dynamic, thermodynamic, wave-dynamic, and frictional conditions
that exist inside each cylinder throughout the entire 720 degrees of the four-cycle
process.

Other simulation programs may simply calculate the volumetric efficiency (VE)
and then derive an estimate of torque and horsepower. There are many shortcomings
to this and similar "shortcut" techniques. The two greatest drawbacks are: 1) since
cylinder pressure is not precisely determined, it is impossible to predict the pressure

Iterative Testing™ is a power-  ERVEVS T NIV (o[ gz (o) Ul [ (101
ful feature included in both the

Filling-And-Emptying and Wave-
Action models. This screen illus- e .
trates a test evaluating a series | [ . .7
of components (over 200 dyno

tests have been performed). | e B B et
Using this powerful tool it is a0
possible to automatically run -
thousands or even hundreds of g
thousands of tests to find the " e
best combinations. The simula- | e = fer =i

tion keeps track of all the results
and displays the best matches to e
your test criterion.

12—Dynomation6 & DynoSim6 Engine Simulations, v6.03.38, 060124

Quick Iterator.

W Stapped Press begin ensive Iterator test ssiies 1o loca
Components/specs thak produze the highest horszpouel ortigue,




Introduction To Version6 Simulations

on the exhaust valve and the subsequent mass flow through the port when the ex-
haust valve opens, and 2) the inability to accurately determine pumping horsepower
losses (energy needed to move gasses into and out of the engine) substantially
reduce accuracy and applicability across a wide range of engines.

Version6 simulations incorporate models that include frictional, charge flow, and
pumping-loss calculations. Extensive computation is required for each power point, in
fact, the simulations perform several HUNDRED MILLION calculations at each rpm
point throughout the rpm test range. However, due to the advanced mathematical
analysis possible with modern Giga-Hertz-speed computers, most engine simulations
can be completed in about one second in DynoSim6 and, typically, 1 to 10 seconds
in Dynomation6!

The in-depth analysis provided by version6 simulations can be applied to a vast
range of engine designs. Both DynoSim6 and Dynomation6 have been successfully
used to model single-cylinder “lawn-mower” engines, light aircraft engines, automo-
tive engines, 2-, 3-, 4-, and 5-valves-per-cylinder, high-performance racing engines,
ProStock drag-racing powerplants, Formula-1 engines, multi-thousand horsepower
supercharged, nitrous-oxide injected “mountain motors,” and many other engine de-
signs.

WHAT'S NEW IN Version6

If you have used earlier versions of our simulations, you will find version-6 simu-
lations offer a significant upgrade. During the development cycle for these products,
many aspects of the program were improved, including cam-timing and lift-curve
modeling with the use of all-new Fitter (accuracy improving math) routines, enhanced
user interface functionality, new graph-and-table results displays, more accurate
forced-induction modeling with improved Compressor Map and Engine Demand
Line displays, plus substantial improvements in exhaust-system modeling, both in
DynoSim6 and Dynomation6. Here's a short list of some of the new features and
changes in version6 simulations:

*  Exhaust modeling in WA supports three primary sections (pipes), two collector
sections, and a megaphone from which you can design any header system.

* Exhaust modeling in FE now includes stepped headers, Tri-Ys, and more.

*  “Fitter” math routines ensure optimum valve-motion accuracy.

* New fuels and Diesel modeling supported; CRs extended to 30:1.

*  Nitrous-Oxide injection now uses step-wise analysis of Nitrous charge.

* Improved Latent Heat Of Vaporization fuel modeling.

* Intake runner temperature modelling.

WA "optimum cycle count" automatically determined.

* Pressure-Wave Stability indicators give at-a-glance warning of issues.

* WA Manifold-Plenum and Runner-Bellmouth modeling.

* FE displays pressure waves and particle flow velocities, similar to WA.

* FE includes new exhaust models and tubing-size prediction.

* Automatic step-by-step analysis of optimum exhaust pipe lengths.
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WA lterator finds best Intake Runner-Length and Runner-Areas.

* Improved Forced-Induction modeling and Turbo Map displays.

* Model up to four compressors (any type) on any engine at once.

« Simulation Log feedback helps diagnose modeling issues.

* Graph Coefficient of Discharge (CD) and Curtain Areas for all valves.

+ Tables display Mass Flow, in Lb/min and Kg/sec, at each RPM step.

«  Enter custom conversion factors for Brake-to-Wheel Horsepower.

* Improved Units handling for US and Metric; new Hybrid Unit modes!

*  Motion has released a series of YouTube Videos (with more to come) that are
intended to provide tech tips and support for Version6 and earlier simulations.
Check them out here: www.youtube.com/@motionsoftwaresim

* Our videos will help you find even more simulation tools and features!

The display and analysis of pressure waves in the intake and exhaust ports also
has been improved in Version 6. Click on the power/torque graph to select any rpm
point; you will instantly see the status of pressure waves and mass flow for that en-
gine speed for both the WA and FE simulations. Drag the reticule line on the power/
torque graph; the pressures and flow dynamics will instantly update as you scan
through the rpm range. This capability provides an unprecedented view of pressure
and particle flow within a “running” engine for both WA and FE simulations.

Enhancements were added to lterative Testing,™ an exclusive feature of Motion
Software simulations. /terative Testing allows you to automatically perform thousands
of dyno tests, keep track of all the results, and locate the best component combina-
tion that matches your search criterion. In addition to cam valve-event timing, intake
manifold selection, and bore and stroke values, you can now lterate cam centerline
timing and intake runner lengths and areas (port length and area iteration applies
only to the WA simulation).

Version6 also offers many additional improvements. Diesel modeling is now
supported with compression ratios as high as 30.0:1. Latent Heat of Vaporization
modelling better simulates intake-charge temperatures, particularly with supercharges
and racing fuels, like methanol. Manifold runner wall temperature can be modeled
to directly support "air-gap" manifolds and other unique manifold/runner ambient
conditions. Cam Dynamic Stability Indicators have been included to alert the user if
the current cam timing values have caused stability issues. Additional Dynomation6
indicators in the Induction and Exhaust categories show potential issues (such as
shock waves) in the intake and exhaust runners.

But most important is what hasn't changed: Our top-tier tech support. Motion
Software, Inc., development staff will be available to help you if you run into issues
that you can't solve on your own. We are always interested in helping you succeed
with our simulation software. Let us know how we can help!

Program Requirements

Here are the basic hardware and software requirements needed to run our simu-
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Dynomation6 and
DynoSim6 use two
distinct simulation

models: The Filling-
And-Emptying (used
in DynoSim6) and the
Wave-Action (used in
Dynomation6). Each

of these simulation
methods have their
strong points, and just
like selecting the right
tool for the job, select-
ing the best simulation
model will help you
find optimum compo-
nent combinations in
the shortest time and
at the lowest cost. Re-
fer to page 264 for fur-
ther details about each
Simulation's Capability
(the numbered items in
this chart).

lations:

Dynomation6 Wave-Action And DynoSim6

Filling-And-Emptying Functional Differences

Motion Engine Simulation
Capabilities

Filling-And-Emptying
Simulation

DynoSimé and
Dynomationé

Wave-Action
Simulation

Dynomation6
Only

Dyno-Testing RPM Range

1000 to 14500 rpm

1000 to 14500 rpm

Bore Range Limits

2.00 to 7.00-in

2.00 to 7.00-in

Stroke Range Limits

1.50 to 7.00-in

1.50 to 7.00-in

Forced-Induction Modeling (1

Extended-Data Displays (2]

ProPrinting™ Extended Dyno Reports (2|

ProData™ Tables (4]

Graph DataZones™ (5]

Prolterator™ Testing (6]

Analyze Area Under Power And Torque Curves (7,

Full Wave-Action Simulation (8|

No

Analyze Induction & Exhaust Pressure Waves (9

Model Intake & Exhaust Runner Lengths & Taper Angles (10

No

Megaphone/Normal Headers (11

parent 3D-Engine P Analysis Display (12

Graph Reticle Synchronized With 3D Engine Analysis (13)

Import Earlier Engines, Port Flow And CamFiles (14

Import FlowPro Flow-Bench Files (15)

Import CamPro+, S96, CamDoctor Lobe-Profile Files (16)

Supplied With 3500+ Lobe-Profile Library (17)

Optional

Included

View 3D-Engine Mass-Flow Analysis (18]

Yes

Yes

A Windows-compatible PC (with a CD-ROM drive if you purchase our products
on CD, however, a CD not required for Direct Download software delivery).
A USB Port for the supplied Security Key when running Dynomation6 (see
INSTALLATION for more information on program security).

Note: The Dynomation6 Security Key is not compatible with Microsoft Insider
Program versions of Windows.

A minimum of 4GB of RAM (random access memory) for Windows 7, 8, 10
and 11. More memory than this can improve program performance.
Windows 7, 8 , 10 or 11 (32- or 64-bit). Note: Version6 software may run on
earlier versions of Windows (such as XP and Vista), but these installations
are not supported.

An Internet connection is required to obtain Free program updates (you can
receive periodic updates, all free for registered users of Version 6 software).
Note: Automatic updates over the Internet are not supported in Windows
2000 installations.

A video system capable of 1280 x 1024 or higher will optimize screen display
of engine components and graphics.

A fast system processor (the faster the better) will improve processing speeds;
especially helpful for Wave-Action and lterative testing. However, Version6
simulations will operate on any Windows qualified system, regardless of
processor speed.
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* A mouse/mousepad/trackball is required for cursor movement and component
selection.

* Any Windows compatible printer (to obtain dyno-test printouts).

* In Dynomation6, you can export simulation data in a format that is readable
by Microsoft Excel (spreadsheet). Excel (or a compatible product) is needed
to utilize this feature.

Additional System Requirements
And Considerations

Windows 7, 8, 10 and 11: This software is fully compatible with Windows 7, 8, 10
and 11 (either 32- or 64-bit versions). Make sure to install all the latest service packs
and updates (use the Microsoft Windows Update feature to update your operating
system).

Windows 2000/XP/Vista: Our testing shows that Version6 simulations will usually
operate properly on WindowsXP and Windows Vista. Make sure to install all the lat-
est service packs and updates (use the Microsoft Windows Update feature or visit
www.microsoft.com to locate updates and service packs for your operating system).
Note-1: Windows95 is not supported.
Note-2: We recommend that you run our simulations on Windows 10 or 11 ma-
chines. Our testing shows that these operating-system versions are the most
sophisticated and reliable (and best supported).

Video Graphics Card And Monitor: An 800 x 600 resolution monitor/video card
is required to use version6 simulations. Systems with 1280 x 1024 (HD) resolution
will obtain more screen “real estate,” and this is very helpful in component selection
and power/pressure-curve analysis. Screens of 19-inches or larger with 1280 x 1024
resolution or higher are optimum for simulation testing.

System Processor: Version6 engine simulations are extremely calculation-intensive.
Over 2 billion mathematical operations are performed for each complete power-curve
simulation. While the program has been written to optimize speed, a faster proces-
sor will improve data analysis capabilities. Furthermore, our simulations incorporate
powerful /terative Testing functions that perform an analysis of hundreds or thousands
of simulation runs. To reduce calculation times and extend the modeling capabilities
of the program, use the fastest processor practicable.

Mouse: A mouse (trackball, or other cursor control device) is required to use this
software. While many component selections can be performed with the keyboard,
several operations within this simulation require the use of a mouse.

Printer: Dynomation6 and DynoSim6 can print a comprehensive ProPrint™ “Dyno-
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Test Report” of the simulated engine on any Windows-compatible printer. If you use
a color printer, the data curves and component information will print in color.
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INSTALLATION

Note: In most cases, you can install Motion Software products simply by
following on-screen prompts. As additional help, the following steps 1
through 8 provide information that will ensure a trouble-free installation. If
you skip this part, we recommend all users review post-installation instruc-
tions later in this chapter:

Installation Overview:

* Dynomation6—As the purchaser/owner of Dynomation6, you are granted
a license to install the simulation on as many computers as you wish, however,
Dynomation will only startup and run on a computer that has the USB Security
Key plugged into a USB port on your system (the USB Key is supplied in your
software package).

*  DynoSim6—As the purchaser/owner of this DynoSim6, you are granted a
license to install this simulation on two computers for your personal use. Instal-
lation on more systems, or “loaning” this software to friends, is a violation of the
Motion Software License agreement.

*  Make sure all other applications are closed before you begin this installation.
The best way to do that is to restart your system, then begin this installation be-
fore you start any other programs. If other programs are using system resources
during Dynomation installation, your computer may appear to “lock-up” when in
fact, another application (“hiding” in the background) has taken focus away from
the Dynomation installer.

* Note: You must have Administrator Rights to properly install Dynomation
under Windows 7, 8 and 10. Administrator Rights are also required to receive
automatic updates over the Internet.

Program Installation Steps

1) Close all other applications before you begin this installation.
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3)

Insert the simulation
CD-ROM into your
CD drive.

A Software Installa-
tion Menu will open

omation6 Install Menu
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Installing & Starting Version6 Simulations

From the op-
tions provided

. Installation Menu in the Instal-
on your Desktop with- ; lation Menu,
in 5 to 30 seconds. *Dynomation-6™ Betad select Install

) stalls Full Version of Dynomation-6, Betad .
Click the Install op- - Dynomation6
. = CamDisk™ For Dynomation6 I Je or DynoSim6.
tion. Installs CamFile Library For Dynoglatio,
Note: Install Dynomation§ first! i If the Menu

Note: If the Software
Installation Menu
does not automati-
cally appear on your
desktop within 30 to 60 seconds, view the contents of the install CD using
Windows Explorer (not Internet Explorer) and double-click on Dynomation6_In-
stallMenu.exe or DynoSim6_InstallMenu.exe to begin program installation.

does not ap-
pear, see the
Note in Step 3.

/I/%ﬂ-ism 2

4) After you select an Install, allow up to two minutes for the program installer to
read files from the CD and display an opening window. Click Next to view the
Motion Software License Agreement. Read the Agreement and if you agree with
the terms, click / Accept...., then click Next to continue the installation.

5) A Readme file is now displayed that includes information about installation and
program updates. After you have reviewed the Readme, click Next to proceed
with the installation.

6) Important Note: This software will be installed on its default path (on your boot
drive, C:\, in the root). This location is essential to ensure that future updates
install properly.

7) The installer Start Installation display gives you a chance to review the license
agreement or readme info. Press Install to begin installation.

8) This step is for Dynomation6 Only:
Installing The USB Security Key

Plug the USB Security Key (the small USB device supplied with Dynomation6)
into any available USB port on your computer. This key is licensed to you, the
purchaser of this software, and will allow you to run Dynomation6 on any of your
computer systems. You are licensed to install Dynomation6 on as many comput-
ers as you wish, however, Dynomation6 will only run on one system at a time;
the computer with the Security Key installed.
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The latest Sentinel-HASP USB Security Key driver will install next. This driver is
required for Dynomation6 to communicate with the USB Security Key provided
in your software package.

Note: If you do not have an available USB port (your computer must have at
least one free USB port to run Dynomation6), you can install a USB Card or Hub
to extend the number of available USB ports. The Dynomation6 Security Key
functions properly with most external USB Hubs.

Next, a dialog box may appear and ask for permission to install Microsoft DirectX
on your system (DirectX is required for 3D animations within the software). If you
have the same or a newer version of DirectX already installed, the installer will
detect its presence and will not overwrite newer files.

Solving USB Security Key Issues

If Dynomation6 displays an error message that the Security Key (or HASP) is
missing, here are some quick steps you can follow to isolate and correct this prob-
lem:

a) Restart Windows after you install Dynomation6 to make sure the USB Key driv-
ers are loaded and running.

b) Make sure the Security Key is, in fact, properly connected to a functioning USB
port on your computer or has been plugged in a USB hub that is connected to
your computer. If you plugged the Key into a hub (rather than into a USB port
on the computer), try connecting it directly to a port on your computer system.
Note: The Security Key contains a small red LED that illuminates when it is
properly connected and communicating with its software drivers.

c) Disconnect all other USB devices from your system, then reconnect the
Dynomation6 Security Key (try a different port if possible).

d) Try reinstalling the Security Key drivers by reinstalling Dynomation6 from the
program CD (you do not need to un-install first), or install the latest driver posted
on our Support page (www.motionsoftware.com/support.htm).

e) If your computer is experiencing technical difficulties, such as non-functional
devices, spontaneous rebooting, numerous system messages, etc., the device
drivers for the Security Key may not function properly on your system. You must
have a stable computer system and a clean, virus-free Windows installation to
properly use this simulation.

f) As a‘“last resort,” try installing the simulation (and the Security Key) on a second
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computer system to determine if your original computer has compatibility issues.

POST-INSTALLATION SETUP
For Both DynoSim6 and Dynomation6

Installing A 10-Point CamDisk Library

9) CambDisks are additional libraries of 10-Point camfiles (much more information
on 10-Point camfiles is provided later in this User Guide). If you wish to install a
10-point library (from a separate install CD or it can be included on the program
installation CD), click the Install option on the Program Installation Menu.
Note-1: CamDisk camfiles can only be installed after the simulation has been
successfully installed on your system.

Note-2: 10-Point camfiles are NOT the same as Lobe-Profile files; refer to the
Camshaft Category later in this User Guide for more information on the differ-
ences between 10-Point valve timing and lobe-profile specifications.

Installing A Lobe-Profile Library

10) Motion Software offers libraries of cam-lobe profiles that allow version6 simula-
tions to model exact valve motion and predict engine power with the highest
accuracy. Lobe-Profile files consist of data that “maps” the entire shape of the
lobe, not simply the valve opening, closing, and maximum lift points used in
10-Point Camfiles. If you wish to install a Lobe-Profile library, click on the Install
option on the Program Installation Menu that will appear on your desktop after
you insert the Profile CD into your CDROM drive.

Note: Profile Libraries can only be installed after a version6 simulation has been
successfully installed on your system.

Starting The Simulation
For The First Time

11) To start the simulation, double-click the Dynomation6 or DynoSim6 program icon
that was installed on your Desktop. Alternatively, you can open the Windows
START menu, select All Programs or Apps, then choose Motion-Dynomation6
Engine Sim, or Motion-DynoSim6 Engine Sim and click on the software icon
displayed in that folder.

Dynomation6 Only: If Dynomation6 displays an error message indicating that
the Security Key (HASP) is missing or cannot be found, refer to the information
on the previous page (Solving USB Security Key Issues).

RegisteringYour Software

12) When you first start the simulation, a Registration dialog will be displayed.
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Please fill in the requested information, including your Serial Number found on
the QuickStart Guide provided in your software package.

Note: If you are installing software that you have downloaded from the Mo-
tion Online Store, you will find a temporary registration number visible just
above the Registration Number data-entry fields in the Registration Dialog.
Enter this temp reg number until you receive your permanent number from
Motion Software...you will only have to enter your permanent number once.

Press the Register Now! button to send your registration information to Motion's
servers; an Internet connection is required for data submission. If you do not have
an Internet connection, you will be presented with other registration options. If
you do not register this simulation, you may not qualify for tech support or free
updates.

If you move or change your email address, you can update your registration
information at any time simply by selecting Registration from the HELP menu.
IMPORTANT: Keep up to date with the latest program advances by keeping your
registration information current.

Automatic
Program Updates

13) This simulation incorporates an automatic program updater that will keep your
software current with the latest simulation developments. Before you put the
simulation to work, make sure you allow the Motion Updater to check our servers
and install the latest program updates (requires Internet connection). The Motion
Updater will run automatically after program installation and then approximately
every 30 days thereafter. You can check for a new update at any time by select-
ing Check For Newer Version... from the HELP menu within the simulation.
Important: Don’t assume you are running the latest software version if you just
installed the software from the installation CD. CD’s are NOT updated each time
new releases are issued. The ONLY way to make sure you are running the latest
version is to use the Check For Latest Version feature (in the HELP menu). If
you cannot obtain/install program updates using our Updater, contact technical
support at: support@motionsoftware.com.

Un-Installing The Simulation
You can un-install this simulation by either: 1) Use the program removal feature
in Windows or 2) Use the Uninstaller placed in the Program folder (Start menu,

select All Programs or Apps, then choose Motion-Dynomation6 Engine Sim
or Motion-DynoSim6 Engine Sim, and finally click on the UNInstall).

Solving Other Installation And Operational Problems
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Installing & Starting Version6 Simulations

Important Note: You can review tech-support updates by visiting (www.Motion-

Software.com). Contact our Tech Support staff directly by sending an email to
support@motionsoftware.com.

If you experience problems installing or using this simulation, please review
the information presented in this Users Manual, including the information earlier
in this chapter, the FAQs later in this manual. You can also run Check For Latest
Version features (in the HELP menu) to get the latest simulation updates.

Primary contact information:

Tech Support Email: support@motionsoftware.com
(Preferred Contact Method)

Voice Line: 714-231-3801
Web: www.MotionSoftware.com

And make sure you have a look at our growing list of tech videos on YouTube:
youtube.com/@motionsoftwaresim

Tech Support Email: support@motionsoftware.com This is the best way to
obtain tech support quickly. Always include your email address and attach any
.DXML engine files that may help Motion diagnose problems. Include a thorough
explanation of the steps that lead up to the fault.

Tech support will only be provided to registered users. Please complete the
Registration Form that appears when you first start your software to qualify for
technical support from the Motion Software staff (or select Registration from the
HELP menu in the program).

If you need to update your address or any other personal information, simply
select Registration from the Help menu, make any necessary address changes,
then press Register Now! to transmit your updated info.

Send mail correspondence to:
Motion Software, Inc.

222 South Raspberry Lane
Anaheim, CA 92808-2268
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THE MAIN PROGRAM SCREEN

The left side of the Main Program Screen includes component categories that
you can use to select simulation specifications and enter engine components and
dimensions. The right side of the screen displays simulation results consisting of
graphs, charts and tables. The Main Program Screen is composed of the following
elements (matches numbers in the photo, above):

1) The Title Bar displays the program name followed by the name of the currently-
selected engine.

2) The Program Menu Bar contains pull-down menus that control overall program
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Program Overview

Program Menu Bar
contains nine pull-down

Program Menu Bar

File Edit View Simulation Units Tools ‘Window Help| mMenus that control overall

program function.

function. Here is an overview of these control menus, from left to right:

File—Opens and Saves version6 (.DXML) files; Imports other Motion
simulation files, including previous version Dynomation4 and 5 engine files,
DynoSim4 and 5 and even various DOS-based engine files; Exports crank-
angle and rpm-based engine test results data in an Excel-importable format
(feature not available in DynoSim6); ProPrint™ generates a comprehensive
report of engine components and simulation results, finally, the bottom of the
File menu displays the most recently used simulation files, and contains a
program-exit function.
Edit—Provides a Clear-All components from the currently-selected engine
(the current engine is highlighted on the Engine Selection Tabs at the bottom
of the screen; see Engine Selection Tabs, later in this chapter).
View—Allows you to display the Toolbar(3), Status Bar(8) and Workbook
(see the Workbook note, below) layout features. The View menu also includes
a choice to reset all graphs to program default axis values.
Note: The Workbook features activate the Engine Selection Tabs(7)
at the bottom of the screen, allowing rapid switching between "open"
simulated engines. If you have limited screen space (or you only simu-
late one engine at a time), you can turn off the Workbook features and
access multiple simulated engines from the Windows menu.
Simulation—Run forces an update (recalculation) of the current simulation.
Auto Run enables or disables (toggles) automatic simulation updates every
time a component is changed. You can also display a Simulation Log that
contains diagnostic information about the simulation just completed. The

Each Program Menu pro-
vides access to overall
program features. Here the
Simulation Menu lets you to
choose when the simulation
is performed and whether the
SimLog and Blower-Map dia-
logs are displayed. You can
also open a Program Default
dialog where startup charac-
teristics for the software can
be modified.

Program Menus—Simulation Menu
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Program Menus—Simulation Log

6 - [Stock3505

55> Stock3s0StrestEngine.dmml <<< - A Program Run LOg can be dis-
W [fave Action Model Run played using the Simulation drop-
Number of integration cycles run for convergence: down menu. Thls prOVideS info
Simietion slapad came: 224:2%0 about the just-completed simulation

process, including execution times.
Errors, like the lack of convergence
or intake restriction warnings (if gen-
erated), can be helpful in diagnosing
component-setup and other simula-
tion issues.

Graph...On Baseline selection will re-scale pressure graphs to position the
curves on the baseline (helpful when modeling forced-induction engines).
A Blower Map Window can be displayed that shows the compressor map
and engine demand line for Turbo and Centrifugally supercharged engines;
essential in diagnosing compressor selection, surge or choke issues.
Note: A compressor map will only be displayed when a map is avail-
able for the selected compressor. Most compressors featured in version6
simulations are modeled with typical compressor maps (over 300 maps
are included with the simulation as of 2024), however, there are a few
compressors for which maps were not available and it was possible to
use a "pure math" approach to model compressor performance.
The Simulation menu also includes a Program Setup selection that lets you
personalize simulation startup and operational characteristics.
Units—Selects between US/Domestic and Foreign/Metric units. Hybrid units
systems are also available that display component values in Metric units with
Power and Airflow in US units.
Tools—Opens Quick and Prolterator™ testing windows, the Cam Man-
ager™ dialog, or one of several built-in, cam/airflow/conversion calculators.
Window—A standard Windows menu for arranging and selecting engine
display windows.
Help—Gives access to this Users Guide, Program Registration, Program
Updates and related program features and information.

3) The Tool Bar, above the component categories, contains a series of icons that
speed up the selection of various program functions and features. The Tool Bar
contains the following icons/functions: 1) Create New Engine, 2) Open Saved
Engine, 3) Save Current Engine, 4) Open Quick Iterator, 5) Open Pro Ilterator™,
6) Open Port Flow Dialog, 7) Open Compression-Ratio Calculator, 8) Open
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Component Category Status

Data Entered

The status of the Component Categories
are indicated by the color of the Cat-
egory Title Bars. The Title Bars are either
red tone, indicating that required data
has not been entered (inhibiting a simu-
lation run), or dark tone indicating that
all required data in that category has
been entered. The simulation determines
whether a category is “complete” based
on the simulation method selected. For
example, the Filling-And-Emptying model
requires fewer data values than the
Wave-Action model. As a result, cat-
egories may indicate dark when Filling-

Sim,

All Required —

Category —
Incomplete

[indaction And-Emptying is active, but may switch
[camshaft to red when the Wave-Action model is
% activated, indicating that additional data
Notes in those categories is required.

4)

5)

Airflow-Conversion Calculator, 9) Open Piston Animation, 10) Open Crank-Angle
SimData™ Window, 11) Generate A ProPrintout™ Of The Current Engine, 12)
Display Program “About Box.”

The Simulation Category is the topmost Engine Component Category(5), and
is titted Simulation. Use this group to select a simulation model (in Dynomation6
only) and make simulation-specific setup choices, such as engine-test rpm range,
ambient atmospheric conditions, etc.

The remaining Engine Component Categories are made up of the following
groups:
ShortBlock—Select the bore, stroke, number of cylinders, pin-or-piston off-
set, rod length and/or rod ratio in this category. Dynomation6 also provides
an Engine Friction selection that models internal engine friction for various
engine buildups.
Cylinder Head—Select the cylinder head type from generic choices in the
menu or enter custom data using the Port-Flow dialog (click the Port-Flow
button).
Induction and Forced Induction—Select intake manifold designs, airflow
rates, pressure drop and runner temperatures for the induction system. Also
select intake runner and plenum dimensions for the Wave-Action simulation.
Select "Baseline" modeling to begin your engine development.
At the bottom of the Induction category you can activate and configure a
Forced-Induction Systems for any engine. Roots and Screw blowers, Cen-
trifugal superchargers, and Turbochargers are supported. Each engine can
support up to four attached superchargers (1 to 4 compressors).
Camshaft—Select the camshaft type, activate V-V-T (variable valve timing
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Component fields that do not yet contain
valid entries are marked with a series of
asterisks. This indicates that the field is

empty and can accept data input. Most
numeric fields accept direct keyboard
entry and/or selections from the pro-
vided drop-down menus. Some selec-
tion fields (like the Cylinder Heads Type
menu) only accept selections from the
associated drop-down menu. When a
valid selection has been made, it will
replace the asterisks.

Incomplete Component Fields

@ Manual Entry

Empty Component

similar to Honda’s VTEC; see the Camshaft chapter for more information),
set various cam timing/specifications, and displays True Timing used by the
simulation (measured during the actual simulation run). Buttons open the
CamManager™, Rocker-Math™ dialog, and the Lobe-Profile Import dialog.
Combustion—Selects the compression ratio, the type of fuel, air/fuel ratio,
nitrous flow rate, combustion chamber design, and ignition timing.
Exhaust—Selects the exhaust-system configuration. Runner and tubing
dimensions and interconnection specifications are available in Dynomation6.
Notes—Enter any comments about the current simulation. Your comments
are saved with the engine .DXML file.

Note: Each component category indicates its status by the color of the Category
Title Bar. The Title Bars have either a red tone, indicating that the category is
not complete (inhibiting a simulation run), or a dark-tone indicating that all com-
ponents in that category have been selected. When all component categories
indicate complete, a simulation can be performed (calculation will begin automati-
cally if the Auto Run feature is selected in the Simulation Menu).

The Main Program Screen win-
dow is divided into two panes.
The left and right portions of
each contain a set of Screen
Display Tabs located at the
bottom of the panes (left-most
tab is highlighted in the photo).
Use these tabs to switch the
display to Engine component
lists, Tables, Graphs, or other
data displays.

Program Screen Display Tabs

Tapel

or Pipe Length:
-IID”I [Endto E

VRT3 DI\ Engine § Grach J Tabe } Proda } Crank Data J
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Engine Selection Tabs

ITIEL LAd,

The simulation can work with several
engines at once. Switch between "open™
engines by choosing from the Engine
Selection Tabs, located just above the
Status Bar at the bottom-left of the main
program screen (right-most tab is
selected in this photo).

Note: the Status Bar (7 & 8 below) dis-
plays “Ready” (to run sim).

6a & 6b) The Main Program Screen window is divided into two panes. The left
and right panes each provide a set of Screen Display Tabs at the bottom. Use
these tabs to switch the left and right panes to tables, graphs, or other simula-
tion displays.

7) This software can simulate several engines at once (supports multiple open
documents). Switch between “active” engines (documents) by selecting any open
engine from the Engine Selection Tabs, located just above the Status Bar at
the bottom of the main program screen (engine selection can also be made from
the Windows Menu). The current engine is highlighted on a foreground Tab. The
name of the currently-selected engine is also displayed in the program Title Bar.

8) All Component Category menus allow either direct numeric entry or menu-selec-
tion choices, and some accept both. During data entry, the range of acceptable
values and other helpful information will be displayed in a Range Limit Line
within the Status Bar at the bottom-left corner of the main program window.

9) Several component categories contain QuickAccess Buttons™ that give “one-
click” access to important data-entry functions and calculators. The CYLINDER
HEAD category contains a PortFlow button that opens the Port-Airflow dialog
box, allowing direct entry of flowbench data; the COMPRESSION category con-
tains a CR Calc button that opens the Compression-Ratio Calculator, a tool that
can save time and improve accuracy in determining engine compression ratio;
the INDUCTION category contains a FlowCalc button that allows quick airflow
calculations from throttle diameter, etc.; and the CAMSHAFT category contains
the CamManager™, Rocker Math™, and Import Profile buttons that give ready
access to important tools that help you with cam simulation and valve-timing
modifications.

10) The widths of all program panes are adjustable. Simply drag the Vertical or
Horizontal Screen Divider to re-size the Component-Selection and Graphics-
Display panes. Horizontal Dividers are located between the right-hand graphs.
By adjusting the position of these dividers, you can increase the display size of
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SimData™ Window

1896 hp T4 .4
311.21b 421.9 MM
16000 f/m [ET /s
285

28 %

The Crank-Angle SimData™ Window displays :
the exact values of port pressures, flow rates e 0.6 1372 psi
and other simulation data at various rpm and s e

crank-angle values. Click on the rpm graph
to set the rpm reticule line, then click on any
crank-angle graph to display a crankangle reti-
cule. As you drag the reticule left and right,
exact data values at the reticule intersections
will be displayed in the SimData™ Window
(open the SimData Window from the Tools
drop-down menu).

the power-curve and pressure/flow displays to suit your analysis.

11) The Simulation Progress Indicator (appears in the Status Bar when a simula-
tion calculation is underway) shows the progress of calculations for the selected
simulation model. Each “step” of the progress bar indicates the completion of
a simulation at one rpm point. Note: Some engine simulations, particularly with
forced induction, may require multiple passes of the Progress Indicator to com-
plete the simulation process.

12) The Crank-Angle SimData™ Window (see photo, next page) displays the exact
values of port pressures, flow rates, horsepower, and more at various rpm and
crank-angle points. Click on the rpm graph to set the rpm reticule line, then click
on any crank-angle graph to display a crankangle reticule (see 17, below). As
you drag the reticule left and right across the graph, exact data values under
the reticule intersection will be displayed in the SimData™ Window (open the
SimData Window from the Tools drop-down menu).

13) The Port Velocity lower graph displays port flow rates at various rpm and crank-
angle values (velocity is default display; it can be customized in the right-click
Options menu). The displayed velocity values are calculated at the location of
minimum cross-sectional area in the port. Click the top horsepower/torque graph
to display a reticule line and establish the rpm for viewing flow and pressure data.
Drag the reticule left and right on the RPM graph to establish the port flow data
(in the lower graph) at each of the selected engine speeds. Click on the Port
Velocity (lower) graph to display a crank-angle reticule line; the exact data at the
reticule intersection are displayed in the SimData™ Window (see 12, above).
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14) The Port Pressures are displayed in the middle graph (pressure is the default
display; can be customized with a right-click Options menu). The displayed
pressures are calculated at the location of the minimum cross-sectional area
in the port. Click on the top RPM-based horsepower/torque graph to display a
reticule line and establish the rpm for viewing pressure and velocity data. Drag
the reticule left and right on the RPM graph to establish the port pressure data
(in the center graph) at each of the selected engine speeds. Click on the Port
Pressures graph to display a crank-angle reticule line; the exact values at the
reticule intersection are displayed in the SimData™ Window (see 12, above).

15) The various graphs display horsepower, torque, port pressures, flow rates,
valve lift, and more for the currently-selected engine. These graphic displays
can be customized to display additional data in many formats using the Graph
Options Box. To display the Options Box, right-click on any graph; reassign
the X, Y1 (left axis) and Y2 (right axis) curves to any of the data sets provided
in the submenu. Optimize functions quickly setup curves for best visual resolu-
tion. QuickCompare™ will define sim "baselines" to help evaluate changes or
establish comparisons with other engine files (discussed in detail later in this
manual). Finally, use the Properties choice at the bottom of the menu to open
the Graph Properties box where you can assign custom axis values and setup
multiple engine-to-engine comparisons.

16) The Horsepower And Torque top engine-rpm graph displays engine output
throughout the simulation speed range (HP and Torque are the default displays;
the graphs can be customized using the right-click menu). Click on the graph to
display a reticule line. The exact data at the reticule intersection can be viewed
in the SimData™ Window (see 12, and photo on previous page). In addition,
horsepower and torque results (and much more) are displayed in the data tables;
click the Table, ProData, or the Crank Data Screen Display Tabs near the

The Graph Options Box allow you to -
customize any graph. Right-Click to Graph Optlons Box
Reassign the X, Y1 and Y2 curves to L_
different data sets, to set Optimize func- -
tions, to setup Quick Comparsions, to
assign custom axis Properties and setup
multiple engine-to-engine comparisons.
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The DirectClick™ Component Menus . .
allow you to select components and DirectClick™ Component Menus

specifications for each Component Cat-
egory item (Combustion-Chamber design
is shown here). Click on any component
specification to open its menu. The
menu will close when a selection is com-
plete (or accept the current selection by
clicking on the green checkmark). If you
wish to close the menu before making a
new selection, click the red X next to the Exhaust

drop-down box, click anywhere outside -
the menu, or press the Escape key until
the menu closes.

bottom left and right of the Main Program Screen (see 6a & 6b, earlier in this
section).

17) Each of the four graphs (the fourth is located “under” the Component Categories;
click on a Graph Tab at the bottom of the left main-program window) incorporate
a Reticule Line that appears when you left-click on the graph. You can “drag” the
Reticule Line left and right across the graph between the lowest and the highest
test rpm (for the horsepower and torque graphs), or between 0- and 720-degrees
of crankshaft rotation (for the middle and lower port pressure/velocity graphs).
The exact values of the underlying data at the reticule intersections is displayed
in the SimData™ Window (see 12, earlier in this section).

18) The Main Program Screen incorporates Windows Size Buttons. These buttons
provide standard maximizing, minimizing, and closing functions common to all

; . . Component fields that support direct nu-

Fields Accepting Direct Input meric entry have white bounding boxes
embneton R (left). When the only selection possible is
a choice from the drop-down menu, the
bounding box will have a gray interior
(below).

Combustion

B

i White Background:
Numeric input
accepted.

Fields Not Accepting Direct Input

induction

selection from
drop-down menu.

10.00:1
10,501
11.00

Gray Background:
No numeric input
accepted.

Make selection from
drop-down menu.
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Windows applications. Refer to Windows documentation for more information on
the use of these buttons.

19) The Pop-Up DirectClick™ Component Menus allow the selection of compo-
nents and specifications within each of the Component Categories. Click on any
component specification to open its menu. The menu will close when a selection
is complete. If you wish to close the menu before making a new selection, click
the red X next to the drop-down box, click anywhere outside the menu box, or
press the Escape key until the menu closes.

Direct-Input vs. Menu-Input Component Categories

Component menus fall into three categories: 1) Those that accept direct user
input (custom values), 2) those that only accept a selection from their attached
drop-down menu, and 3) those that accept input from either direct input or menu
selections. For example, the Number Of Cylinders menu in the ShortBlock cat-
egory will accept direct input (any integer value from 1 to 16), and you can also
select typical cylinder combinations from the drop-down menu. When a menu
supports direct-data entry, the component-entry bounding box will have a white
interior (see photos). On the other hand, the Pressure Drop menu associated
with the Total Induction Flow Rate, will only accept one of the two selections
from its attached menu (1.5- or 3.0-inHg). The data-entry boxes for these input
fields have a light-gray interior (rather than white).
Note-1: Almost all custom-input categories include an attached menu from
which common data inputs are also provided.
Note-2: Data entry into any component field is limited to values over which
this software can accurately predict power. The range limits are displayed
in the Range Limit Line within the Status Bar at the bottom-left of the
Main Program Screen. If you enter an invalid number, the simulation will
sound the Windows error tone and wait for new input.

Keyboard Selections And Shortcuts

The following keyboard “speed tips” will help you make the process of data entry
and “what-if” testing more efficient. None of these operations are essential, and if you
prefer to only use a mouse, you can skip this section.

Cursor Arrow Keys Move Reticule Lines—You can move the reticule lines on
any of the graphs in small increments by using the Cursor Arrow keys. First, click
on a graph to “select” it, then use the Right-Arrow key to the move the reticule
line to the right; use the Left-Arrow key to move it to the left. If you hold the
SHIFT key, the increment of movement on the crank-angle graphs increases to
10-degrees.
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Opening Menu-Bar Menus—Press and hold the Alt key, then press the F
key to highlight and open the File menu (in the Menu-Bar at the top of the
program screen). Use the cursor-arrow keys to move through menu selec-
tions; press the Right-Arrow key to open submenus and the Left-Arrow key
to close submenus. With any menu open, you can also use the right-and-left
arrow keys to activate other menu-bar menus—e.qg., Edit, View, Simulation,
etc. When you have highlighted the menu selection you wish, press Enter

to accept the selection. Press ESC (the escape key) repeatedly to close the
menus without making a selection.

Note: You can also use the Alt key combination with the E, V, S, U, T, W,
and H keys to directly open the other program drop-down menus.

Moving Through Component Fields—After you have selected any field within
a component category, you can press the TAB key to move the highlight from
field to field within that category. Tab-key presses will not open fields for data
entry, but rather will move the focus highlight from field to field. Tabbing keeps
field selection within the current category.

Note: The Shift Tab key combination will move the highlight box backwards to
the previous component field.

Entering Data In Component Fields—\When you've highlighted a component
field, press the Enter key once to convert the highlight to a data-entry bounding
box. Then key in your data (or open the drop-down menu and make a selec-
tion), finally press the Enter key again to close the bounding box and accept
the data. To move to the next field, you can press the Tab key, or you can again
press Enter. Using Enter instead of the Tab key not only moves the highlight to
the next field, but also opens the data-entry bounding box in one step. So by

The colors used on the compo-
nent-selection screen provide
information about what fields are
currently being used and whether
you can modify these components.
This is the Dynomation6 (default)
color scheme applied to DynoSim6;
White/Cyan indicates components
that can be entered and modified,
while white/light-gray are fields
that indicate “display-only” (like
Runner Connections and Average
Taper Angle, shown in the Induction
category.).

Screen Colors
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pressing keys in the sequence “Enter, Enter, (data entry), Enter Enter,” you can
quickly enter (or jump past) data in component fields within a specific component
category.

THE MEANING OF SCREEN COLORS

The colors used on the component-selection screen provide information about
various engine components and specifications. Here is a quick reference to screen
color functionality; these descriptions apply to the default color scheme:

White: Most engine component field names (not the component values) are
displayed in white. This indicates that their associated data fields are required
for a simulation to be performed.

Light Blue (Cyan): Engine component values displayed in light blue can
be entered into the program and/or modified. For example, the value of Total
Induction Airflow in the Induction Category is Cyan and can be changed to any
value within the limits of the simulation.

Light Gray: These “display only” values have been automatically calculated
by program and cannot be directly modified. For example, the Average Taper
Angle value in the Induction Category is a display-only value that is determined
by the minimum and maximum port areas (values that you can enter in the pro-
gram).

Note: The basic color functionality described here applies to the DynoSim6 de-
fault color scheme. While other color schemes may use some of these colors,
not every color scheme uses the same default colors for data inputs. However,
the differences in display colors within each color scheme will always reflect the
same functionality described here.
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FIVE-MINUTE TUTORIAL

Building And Testing An Engine
Using DynoSim6 And Dynomation6 Simulations

This tutorial is primarily intended for first-time users of Dynomation6 and
DynoSim6 simulations. However, anyone wishing to get an overview of basic
data entry, simulation setup, and results analysis can benefit from reviewing
these step-by-step examples.

Also, make sure you have a look at our growing list of tech videos on YouTube:
youtube.com/@motionsoftwaresim

We are sure they will help you get the most from our Version 6 Simulations.

The most common method of starting an engine-simulation project in this simula-
tion is to “assemble” a test engine from component parts. In this tutorial, we'll quickly
build a basic engine using the Filling-and-Emptying-Wave-Assisted simulation (this
simulation model is used in DynoSim6 and it is also selectable in Dynomation6 in
addition to the full Wave-Action Model).

After obtaining initial simulation results later in this section, we'll modify a few
components to determine how they affect engine output. Finally, we'll switch to the
Full-Wave-Action model (for Dynomation6 users) and continue to fine-tuning engine
components. While this may take you more than five-minutes to complete, once you
are familiar with the simulation, you'll be able to do similar engine buildups and basic
testing in less than five minutes!

Note: Engine power values and other simulation results shown in this tutorial
may vary as the software is updated and/or new features are incorporated over
time. The results shown here reflect the current version of the simulation at the
time this chapter was last updated (the software version at publication is shown
next to the page numbers, at the bottom of the pages).

Getting Started: Building An Engine From Scratch

1) If necessary, start the simulation program and select New from the File menu.
Component categories on the left side of the program screen begin empty, indi-
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The DirectClick™ Component Menus [RSEICE VRIS Cl sz ]
allow you to enter component values
and specifications in the simulation.
Click on any component specifica- [ = 1000
tion to open its menu. Click on the e
down-pointing triangle symbol inside
the bounding box to open a drop-
down menu of possible choices. The
menu will close when a selection is
complete (or manually accept the
current selection by clicking on the
green checkmark). If you wish to
close the menu before making a new
selection, click the red X next to the
drop-down box, or press the Escape
key until the menu closes.

1500

2000

cated by a string of asterisks ( ##*** ) next to each incomplete data field.

2) Data fields in the Component Categories accept your inputs within a “bounding
box” that appears after you click on a data field value. Click on the down-pointing
triangle symbol inside the bounding box to open a drop-down menu.

3) Begin the engine build by moving your mouse into the Simulation category and
left-clicking the Filling-And-Emptying-Wave-Assisted radio button, activating the FE
simulation method (this is not necessary for DynoSim6 users, as the FE method
is selected by default). Next, select the Advanced mode (if not already shown in

the FE Integration menu) which provides a good balance between speed and
accuracy in simulation calculations. Finally, choose the RPM Range values for
the simulation as shown here:

The Simulation Category Choices:

* (WA-Only) Simulation Radio Button: Click Filling-And-Emptying Sim.
* FE Integration: Select Advanced Converge.

¢ Simulation RPM Step: 500.

Start RPM: Select 7000-rpm from the drop-down menu.

Finish RPM: Select 6500-rpm from the drop-down menu.

4) Leave the atmospheric fields in the Simulation Category with their default values.
The simulation will use the J1394 Atmospheric Standard as a baseline. This
standard sets the Altitude to 641.7 feet, the Air Temperature to 77 F, the Barom-
eter to 29.23 inches of mercury, and the Humidity to 0%; common atmospheric
conditions used to evaluate IC engines.

5) Now move to the Shortblock category (see photo, next page). Click on the as-
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6)

7)

terisks in the Short Block field (the Navigating The Short Block Menu
asterisks indicate no selection has

yet been made). Review the menu :
choices and select American. When i o
the submenu opens, select Chevy, :
8 Cylinder SB, and finally click the
left mouse button on 350 V8.

Shortblock Category Choice:
* Short Block: Choose the Chevy
350 V8 shortblock.

Pause over each selection to open a se-

The Short Block name, Bore, .
i ries of submenus. When you reach 350
Stroke, Number of Cylinders, Rod g cjick on it to load that selection into

Length, and Pin Offset are now the simulation.

displayed in the Shortblock category.

Note: Each component category has colored Title Bars. They are either a red-
tone, indicating that the category is incomplete (inhibiting a simulation run), or
a dark-tone indicating that all components in that category have been selected
and are valid. Now that you have completed the Short Block category, notice
that the red Title Bar switched to a dark-gray-tone.

Next, move to the Cylinder Head component category and click on the asterisks
( #+%% ) next to the Description field. Select Domestic Cylinder Heads, then from
the submenu, right click on 2-Valve Wedge, HP/Stock Ports And Valves (top of
the second group). Notice that after you have made your selection, the category
Title Bar remains red. This is because Intake and exhaust valve diameters still
need to be entered. To simplify this selection (and illustrate another program
feature), let the simulation make a calculated “guess” of the valve diameters for
you. Open either the Intake Valve Diameter or Exhaust Valve Diameter menu
and select Auto Calculate Valve Sizes. This selection will calculate appropriate
valve sizes based on bore
size, cylinder-head flow,
etc. This completes the
Cylinder Head category;
the Title Bar should now
a dark-tone.

Selecting Intake and Exhaust Port Flow

Cylinder Head Category:

* Description: Domes-
tic Cylinder Heads
/ 2-Valve Wedge,
HP-Stock Ports And
Valves.
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¢ Intake Valve Dia: Auto Calculate Valve Sizes.

You'll notice that the simulation has assigned 1.94-inch intake and 1.50-inch
exhaust valves to the cylinder heads. These sizes were calculated based on the
cylinder head flow, engine bore diameter, and other engine specifications.

8) Continue moving down through the component categories and make the following

selections:

Induction Category Choices:

¢ Intake Manifold Design: Base-
line Common Plenum.

* Runner Taper Angle: 1.5 De-
grees (loaded automatically).

e Average Runner Temperature:
180-degrees F.

e Total Induction Airflow: 650
CFM (for a 4/8barrel carb/
injection).

* Pressure Drop (indicated by the
‘@’ symbol): 1.5-InHg.

Camshaft Category Choices:

e Cam Type: Generic Cams For
2-Valve Engines / Stock Street/
Economy.

* Rocker Ratio: Set both Intake
and Exhaust Rocker Ratios to
1.5:1.

¢ Valve Lash: Set both Intake and
Exhaust Valve Lash to 0.000.

Combustion Category Choice:

e Compression-Ratio: Select
9.5:1.

¢ Fuel Type: Select Basic Pump-
Gasoline.

Exhaust Category Choice:
* Filling/Emptying Exhaust Menu:

The Main Graph Displays

These are typical results curves. Rpm-
based data is shown on the top graph
(horsepower, torque, etc.); crank-angle
based data on the center and lower
graphs (pressures, particle velocities).
Use Data Selection Tabs (at the bottom
of the graph displays) to show results in
tabular form.

HP Manifolds, Muffler With Catalytic Converter.

¢ Exhaust Tune RPM: 5000.
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Table Display Of Simulation Results

Calculated Power and Engine Pressures

Click the Table Tab at the bottom of the graph pane (see photo on previous page) to
switch to a table view of exact power values and other simulation results.

Dynomation6 User Note: Since you are performing a Filling-And-Emptying (FE)
simulation, the component fields that are only related to the Full Wave-Action
(WA) simulation are dimmed and do not require data entry.

Simulation Results: At this point, all the Category Title Bars should be dark-tone,
and the simulation will display power and torque curves. The engine produces
about 230-hp at 4000 to 4500rpm; typical of 1960's era, V8 street engines with
mufflers and restrictive exhaust systems.

Problems?: If the simulation did not run, first check the Category Title
Bars. Have they all switched to dark-tone. Next, make sure that Auto
Run is checked in the Simulation Menu (located at the top of the main
program screen). Finally, check each data-entry field to confirm that 